SimpleCoat Operation Manual

PN 23100600

for use with SimpleCoat Software version 2.10.18

on SimpleCoat (PN 23100005-0001) & SimpleCoat TR (PN 23100005-0002)

GPD Global® Documentation Department
GPD Global®, Inc.
611 Hollingsworth Street,
Grand Junction, CO 81505USA
+1.970.245-0408
request@gpd-global.com
www.gpd-global.com

10/11/2019
# Table of Contents

Legal ..................................................................................................................................................................... iii  
Notices .......................................................................................................................................................... iii  
Safety labels .................................................................................................................................................. iv  
Disclaimers ................................................................................................................................................... iv  
Trademarks ................................................................................................................................................... v  
Warranty ....................................................................................................................................................... v  

Chapter 1. System overview .......................................................................................................................... 1  
1. Theory of operation .................................................................................................................................... 1  
2. System requirements .............................................................................................................................. 2  
3. Specifications .......................................................................................................................................... 2  
4. Special features ....................................................................................................................................... 5  

Chapter 2. Installation and setup .................................................................................................................. 6  
1. Installation ............................................................................................................................................... 6  
2. Power on and setup ................................................................................................................................. 7  
   2.1. Pressure differential switch setup ................................................................................................. 9  
   2.2. Calibrating heads ............................................................................................................................ 9  
3. Installing software .................................................................................................................................. 10  
4. Uninstalling software ............................................................................................................................. 11  

Chapter 3. Operating safety ......................................................................................................................... 12  

Chapter 4. User interface ............................................................................................................................. 13  
1. Controls ................................................................................................................................................ 13  
2. Indicators ............................................................................................................................................... 14  

Chapter 5. Operations ................................................................................................................................. 15  
1. Start up .................................................................................................................................................. 15  
2. Shutdown .............................................................................................................................................. 15  
3. Emergency shutdown ........................................................................................................................... 15  
4. Homing the gantry ............................................................................................................................... 15  
5. Set up for processing ............................................................................................................................ 16  
6. Calibrating needle ................................................................................................................................ 17  
7. Purging a valve ..................................................................................................................................... 19  
8. Loading a program ............................................................................................................................... 19  
9. Running a program .............................................................................................................................. 20  
10. Valve adjustments ............................................................................................................................... 21  
   10.1. Adjusting dispense valve .............................................................................................................. 21  
   10.2. Adjusting spray valve .................................................................................................................... 22  
      10.2.1. How to adjust spray valve ...................................................................................................... 22  

Chapter 6. Programming ............................................................................................................................... 24  
1. Diagram design ...................................................................................................................................... 24  
2. Setting parameters ............................................................................................................................... 25  
3. Creating a program ............................................................................................................................... 27
Legal

Trademarks, warranty, disclaimers, and notices.

Notices

Operator safety

Operation of the system involves electrical power, compressed air, and mechanical devices in addition to the use of hazardous materials. It is important that personnel operating and servicing the system are qualified and fully understand the safety and system precautions.

For their own safety and that of the system, operator(s) must understand machine operations prior to using it.

---

DANGER

A dangerous condition can result for which the safety features installed in the system may be insufficient.

Do not operate the system beyond the guidelines detailed in this document.

---

WARNING

Do not operate a damaged machine/system/device.

Operation of a damaged machine/system/device may cause personal injury and invalidate the warranty.

---

Intended use

Use of the system in any manner other than described in the documents supplied with the equipment may result in injury or damage to the system. Examples include: removing door interlocks, bypassing safety devices, modifications to original design, and using incompatible tools. When using the system, all precautions and operations should be in accordance with local regulations.

Unauthorized use

The System is a self contained design avoiding contact with any accessible area; however, under certain circumstances, it is possible to enter the system while the XYZ platform is powered up. Only fully trained, authorized personnel may do this.
System manual

Note
This document, including the information contained herein, is the property of GPD Global, Inc. and is considered confidential and proprietary information. It is supplied on the condition that it is not to be used, disclosed, or reproduced in whole or in part, for any reason without prior written consent of GPD Global, Inc.

Note
Specifications, descriptions, and all information contained in this manual are subject to change and/or correction without notice.

Note
Although reasonable care has been exercised in the preparation of this manual to make it complete and accurate, this manual does not purport to cover all conceivable problems or applications pertaining to this machine.

Related information
• Chapter 3. Operating safety

Safety labels
Prior to operating the system, identify all safety labels on the machine and read the corresponding descriptions shown below.

- Always wear approved safety eye protection when operating or working near the system.
- In situations where inattention could cause either serious personal injury or damage to equipment a warning notice is used.
- Do not smoke near the system. Always have a fire extinguisher available for emergency use.
- Before operating the system, read and understand the manuals provided with the unit.
- Before performing any repairs or maintenance to the system, turn off power and lock out the power disconnect switch.
- Never place hands or tools in areas designated by this symbol when the machine is in operation. A dangerous condition may exist.
- Warning notices are used to emphasize that hazardous voltages, current, temperatures, or other conditions that could cause personal injury that exist with this equipment or may be associated with its use. Only qualified personnel should enter areas designated with this symbol.
A pinch hazard from moving parts is possible. Avoid contact.

Related information

• Chapter 3. Operating safety

Disclaimers

Disclaimer for GPD Global conformal coating equipment.

GPD Global conformal coating systems are intended for the stated functions at the time of sale. GPD Global is not liable for other uses.

Trademarks

GPD Global® is a registered trademark of GPD Global, Incorporated.

Windows® is a registered trademark of Microsoft Corporation in the United States and other countries.

Trademarks are used throughout this manual. Rather than put a trademark symbol in every occurrence of a trademarked name, we state that we are using the names in an editorial fashion only and to the benefit of the trademark owner with no intention of infringement on the trademark.

Warranty

General Warranty

Subject to the remedy limitation and procedures set forth in the Section “Warranty Procedures and Remedy Limitations,” GPD Global warrants that the system will conform to the written description and specifications furnished to Buyer in GPD Global’s proposal and specified in the Buyer’s purchase order, and that it will be free from defects in materials and workmanship for a period of one (1) year. GPD Global will repair, or, at its option, replace any part which proves defective in the sole judgment of GPD Global within one (1) year of date of shipment/invoice. Separate manufacturers’ warranties may apply to components or subassemblies purchased from others and incorporated into the system. THIS WARRANTY IS EXPRESSLY IN LIEU OF ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Limitations

GPD Global reserves the right to refuse warranty replacement, where, in the sole opinion of GPD Global the defect is due to the use of incompatible materials or other damages from the result of improper use or neglect. This warranty does not apply if the GPD Global product has been damaged by accident, abuse, or has been modified without the written permission of GPD Global. Items considered replaceable or rendered unusable under normal wear and tear are not covered under the terms of this warranty. Such items include fuses, lights, filters, belts, etc.

Warranty Procedures and Remedy Limitations

The sole and exclusive remedy of the buyer in the event that the system or any components of the system do not conform to the express warranties stated in the Section “Warranties” shall be the replacement of the component or part. If on-site labor of GPD Global personnel is required to replace the non-warranted defective component, GPD Global reserves the right to invoice the Buyer for component cost, personnel compensation, travel expenses and all subsistence costs. GPD Global’s liability for a software error will be limited to the
cost of correcting the software error and the replacement of any system components damaged as a result of the software error. In no event and under no circumstances shall GPD Global be liable for any incidental or consequential damages; its liability is limited to the cost of the defective part or parts, regardless of the legal theory of any such claim. As to any part claimed to be defective within one (1) year of date of shipment/invoice, Buyer will order a replacement part which will be invoiced in ordinary fashion. If the replaced part is returned to GPD Global by Buyer and found by GPD Global in its sole judgment to be defective, GPD Global will issue to Buyer a credit in the amount of the price of the replacement part. GPD Global’s acceptance of any parts so shipped to it shall not be deemed an admission that such parts are defective.
Chapter 1. System overview

This manual (PN 23100600) is a reference document for operation of GPD Global conformal coating systems:

SimpleCoat, PN 23100005-0001

SimpleCoat TR, PN 23100005-0002

1. Theory of operation

General theory of operation

The SimpleCoat system is designed for conformal coating spray and dispensing applications. The spray and dispense valves are mounted on a 3-axis Cartesian platform. All spraying/dispensing takes place within the enclosed work area. Safety limits prevent axis overrun. A flexible software program allows full control of spray/dispense head movement.

The user interface allows the operator full control of the system, including:

- machine setup
- manual operation
- program selection

Machine status and error messages display on the computer screen and signal the user via the light tower.

Conveyor theory of operation

When the program Start button is activated, the system begins monitoring SMEMA conveyor signals. It then waits for the input-side conveyor board sensor to register the presence of a substrate before turning on the conveyor. When the conveyor turns on, it will load a product into the work area. The conveyor stops running a few seconds after the work area board sensor registers the presence of a substrate.

At the end of the program, the system receives a signal, per SMEMA conveyor logic, to send the substrate to the next inline piece of equipment. For a batch type system, SMEMA plugs prevent the substrate from exiting the work area.
Conformal coating materials

SimpleCoat is configured to utilize a variety of conformal coatings.

**Note**

It requires skill and experience to develop the ability to coat PCBs well with conformal coating materials. Flexibility in operation, within the boundaries of this manual, can lead to optimized results; trial and error often leads to the best results.

## 2. System requirements

### Software requirements

The system consists of two programs:

- SimpleCoat software for application of conformal coating
- Coating Project file for storage of PCB information

### Computer requirements

SimpleCoat software requires a customer-supplied laptop with:

- Ethernet connection,
- Windows 7 or newer,
- and at least 32MB of available memory.

### Communication requirements

The system communicates with an on-board computer using a standard Ethernet connection.

**Note**

Set the IP address of the computer integrated with the machine as 192.168.1.10.

---

### WARNING

Damage to the system or computer may result if the ground potentials are different. The computer must be at the same ground potential as the system.

## 3. Specifications

### Machine specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Conformal Coating system - SimpleCoat</th>
<th>Tilt &amp; Rotate Coating system - SimpleCoat TR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>Dispense valve &lt;br&gt; Up to 2 valves total. One spray valve and one</td>
<td>Up to 2 valves total. Only spray valves feature Tilt</td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>Spray valve</th>
<th>Conformal Coating system - SimpleCoat</th>
<th>Tilt &amp; Rotate Coating system - SimpleCoat TR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tilt &amp; Rotate function: Tilt ±45°, Rotate ±90°</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Motion Control

<table>
<thead>
<tr>
<th>XYZ Axis Drive</th>
<th>Stepper motors plus ball screw</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>XYZ Repeatability</th>
<th>50 µm (0.002”)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Speed</th>
<th>350 mm/sec (13.78”/sec)</th>
</tr>
</thead>
</table>

### Coating Area (X, Y, height)

<table>
<thead>
<tr>
<th>XYZ Travel with 2 Valves</th>
<th>430 mm x 430 mm x 50 mm (17” x 17” x 2.0”)</th>
<th>394 mm x 394 mm x 50 mm (15.5” x 15.5” x 2.0”)</th>
</tr>
</thead>
<tbody>
<tr>
<td>XYZ Travel with Spray Valve only <strong>without tilt &amp; rotate</strong></td>
<td>457 mm x 430 mm x 50 mm (18” x 17” x 2.0”)</td>
<td>457 mm x 394 mm x 50 mm (18” x 15.5” x 2.0”)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bottom Side Clearance</th>
<th>100 mm (4”)</th>
</tr>
</thead>
</table>

### Conveyor

<table>
<thead>
<tr>
<th>Conveyor Type</th>
<th>Pin chain</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Conveyor Width (minimum)</th>
<th>50 mm (2”)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Conveyor Width (maximum)</th>
<th>430 mm (17”)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Edge Clearance</th>
<th>6 mm (0.25”)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Transport Height</th>
<th>940 mm - 965 mm (37” - 38”)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Communication</th>
<th>SMEMA</th>
</tr>
</thead>
</table>

### Pressure Settings

<table>
<thead>
<tr>
<th>RG1 - main air pressure</th>
<th>6 Bar</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Regulator 2 - material air pressure 1</th>
<th>0-4 Bar</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Regulator 3- air atomizer</th>
<th>0-4 Bar</th>
</tr>
</thead>
</table>

### Operating Control

<table>
<thead>
<tr>
<th>Minimum Requirements</th>
<th>Customer-supplied laptop with Ethernet connection and Windows 7 or newer</th>
</tr>
</thead>
</table>

### Footprint (W x D x H)

| 1 m x 1.40 m x 1.55 m (39.37” x 55.12” x 61.02”) |

### Weight (approximate)

| 275 kg (605 lbs) |

### Certification

| CE |

### Crating specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Conformal Coating system - SimpleCoat</th>
<th>Tilt &amp; Rotate Coating system - SimpleCoat TR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crate dimensions</td>
<td>145 cm x 135 cm x 183 cm</td>
<td></td>
</tr>
</tbody>
</table>

| Crated weight, approximate | 475 kgs (1,047 lbs) |
Facility specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Conformal Coating system - SimpleCoat</th>
<th>Tilt &amp; Rotate Coating system - SimpleCoat TR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air Supply</td>
<td>6 bar (85 psi) dry, clean air</td>
<td></td>
</tr>
<tr>
<td>Exhaust Port</td>
<td>200 CFM or more, 127 mm (5&quot;) diameter</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>110/220 V AC, 50/60 Hz</td>
<td></td>
</tr>
</tbody>
</table>

Environment specifications

<table>
<thead>
<tr>
<th>Description</th>
<th>Conformal Coating system - SimpleCoat</th>
<th>Tilt &amp; Rotate Coating system - SimpleCoat TR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Noise Levels</td>
<td>Below 65 dbA</td>
<td></td>
</tr>
<tr>
<td>Materials and Chemicals</td>
<td>There are no hazardous materials or chemicals used in the system except for the conformal coating application/process.</td>
<td></td>
</tr>
<tr>
<td>Operating Environment</td>
<td>Location</td>
<td>The System must be placed in an area that is level, and away from standing water, overhead leaks or spray areas.</td>
</tr>
<tr>
<td></td>
<td>Temperature and Humidity</td>
<td>The system should be operated within a range of 4° C - 41° C (39° F - 105° F) and at low humidity so no condensation forms on the system.</td>
</tr>
<tr>
<td>Storage</td>
<td>Location</td>
<td>The System must be placed in an area that is level, and away from standing water, overhead leaks or spray areas.</td>
</tr>
<tr>
<td></td>
<td>Temperature and Humidity</td>
<td>The system should be operated within a range of 4° C - 41° C (39° F - 105° F) and at low humidity so no condensation forms on the system.</td>
</tr>
<tr>
<td></td>
<td>Dust and Particulates</td>
<td>The system should be closed tightly, including all connectors and inlets. A dust cover is recommended if the machine is located in a dusty environment.</td>
</tr>
<tr>
<td></td>
<td>Dispensing and Spraying Valves and associated Piping</td>
<td>If the system is to be stored for long periods, valves and pipe work should be flushed with a compatible solvent. This includes valves, pipe work to valves and pressure containers.</td>
</tr>
</tbody>
</table>

Valve specifications

<table>
<thead>
<tr>
<th>Valve Position</th>
<th>Type</th>
<th>Description</th>
<th>Z-Slide</th>
<th>Rotary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Head1</td>
<td>SPV</td>
<td>Spray Valve</td>
<td>Yes</td>
<td>SimpleCoat = NO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SimpleCoatTR = YES</td>
</tr>
<tr>
<td>Head2</td>
<td>NDV</td>
<td>Dispense Valve</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Chapter 1. System overview
4. Special features

Dispense and spray valves
Conformal coatings are applied using two valves in tandem to achieve the best finish. The dispense and spray valves are standard issue with the machine; the volumetric valve is an available option.

- **Dispense valve** - sometimes referred to as the Needle valve, applies a thin, straight line of coating for accurate, close proximity application.
- **Spray valve** - provides an atomized spray line which is less precise along the edge but covers a larger area.
- **Volumetric valve** - volumetric pump with adjustable flow rate for masking and damming. Compatible with Luer tip.

**Note**
Refer to valve-specific manuals for additional details.

External reservoirs for fluid feeding
Fluid is supplied to dispense valves via external reservoirs. Level detects and large reservoirs are available.

Purge and solvent cups
Stainless steel cups are positioned at the rear of the work area. Two solvent-filled park cups keep dispensing tips clean while not in use. Two purge cups capture dispensed material during program purge steps. Each cup has a 150 ml (5 ounces) capacity and is easily removed for cleaning.

Product transport
Adjusting the system to accommodate the next product is quick and easy with a simple manual adjustment.

Internal black light for coating inspection
Because many conformal coatings fluoresce when exposed to a black light, fluorescence can help determine if a product is fully coated. The SimpleCoat platform includes an internal black light; this enables an operator to assess if coating is being properly applied from outside the system.

Fume extraction and exhaust port with sensor
Conformal coating generates toxic fumes that need to be removed from the working environment. Solvents used in conformal coating are heavier than air and settle to the bottom of the work area; therefore, an exhaust port with a filter is located below the work area cover.

Keyed maintenance mode
Adjustments are kept to a minimum on the SimpleCoat system. A lock is provided to prevent operators from opening the front shield during processing, thus preventing fumes from escaping the dispense chamber while also preventing operators from exposure to a moving gantry.

Tilt and rotate
The tilt and rotate model, SimpleCoat TR, allows the spray valve in Head1 to be tilted ±45° and rotated ±90° to reach four sides of a product.
Chapter 2. Installation and setup

Installation consists of two phases:

**Phase 1** - Customer typically collects all necessary information, tools, and equipment; prepares an area for the machine; and unpacks, inspects, and levels the machine; installs and connects cables, and peripheral equipment. Refer to Installation.

**Phase 2** - GPD Global personnel typically finalizes installation and performs machine power up and final set up. Refer to Power on and setup.

1. Installation

**WARNING**

The following procedures should be performed by qualified personnel in accordance with this document and applicable local safety regulations.

**Tools and material required**

- Spanner wrench, 15 mm
- Forklift
- Work gloves
- Allen keys: 3 mm, 4 mm, and 5 mm
- Safety glasses

**Uncrating the system**

1. Maneuver the system to the final operating position.
2. Disassemble the crate by unscrewing the bolts with the spanner wrench.
3. Unpack the system from the strapping and packaging.
4. Remove the bolt anchors.

**Position the system**

1. With the forklift, carefully remove the system from the pallet. Ensure the forks are inserted all the way from the front or back and are long enough to completely support the pallet.
2. Move system to operation location, then lower the system to the ground, ensuring the system feet are at the correct approximate height and all four feet touch down at the same time. Adjust the height of any feet, as necessary.

**Unpacking and inspection**

1. Open the front doors and remove all packaging and strapping materials.
2. Remove all zip ties from gantry.
3. Remove tape securing cups during shipment.
4. Check the total system for damage or loose components.
5. Install the light tower.

**Leveling the system**

Tools required:
- Spirit level
- Spanner wrench: 19 mm

Level the system to existing line of machines, or to level a batch system:

1. Place the spirit level on the front rail.
2. Observe the bubble position and adjust the front feet until the system is level.
3. Place the spirit level on the rear rail and adjust the back feet until the system is level.
4. Place the spirit level across the rail along the left side and adjust the feet until the system is level.
5. After checking for level at each system corner, close the lock nuts on the feet.

## 2. Power on and setup

**Before you begin**

⚠️ **WARNING**

Failure to comply with electrical specifications can result in damage to the machine, as well as personal injury.

The electrical connection must be made by a qualified electrician and must comply with any applicable local standards. Verify the **Main Power switch** is OFF before connecting the system to the power source.

*Figure 2-1. Connection ports - side panel*

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SMEMA ports</td>
</tr>
<tr>
<td>2</td>
<td>Power port</td>
</tr>
<tr>
<td>3</td>
<td>Air port</td>
</tr>
</tbody>
</table>
Procedure

1. Air pressure:
   a. Locate the main air regulator, attach the quick disconnect 8 mm air hose to exhaust port on the left side of machine, and then slowly open the air valve.
   b. Adjust the air regulator (in work area) and the material air pressure regulators (on side of machine) to operating pressure settings. For details, refer to pressure settings in Specifications.
   c. Set up the pressure differential switch. For details, refer to Pressure differential switch setup.

2. Power:
   a. Plug the system power cord into an appropriate power plug.
   b. Ensure the system is properly grounded.
   c. Ensure the quality of the power is sufficient to ensure smooth operation.

3. For a batch system, verify SMEMA plugs are in place in the SMEMA ports.

4. Close all covers.

5. Ground any pressure containers.

6. Ventilation:
   a. Verify the exhaust pipe is operational.
   b. Hook up ventilation system to vent port on rear panel per Specifications.

7. Turn the Main Power switch located on the front panel to ON.

8. Confirm the Emergency Stop button works as expected.

9. Manually - and slowly - move the gantry around the work area to ensure the valves will clear any potential obstacles.

   Note
   In order for the gantry to move freely, the system must be in Emergency Stop mode.

10. Verify, and tweak as needed, the machine safety check values: home location, park location, and limit values.

   \textbf{CAUTION}
   Failure to successfully enter the machine safety check values will return a critical fault which shuts down the system.
   If repeated machine safety check failures occur, request qualified maintenance personnel examine and test the system before placing the system back in operation.

11. Confirm the Home, Purge, and Park buttons in the main menu button bar operate as expected.

12. Valves:

Chapter 2.
Installation and setup
a. Inspect each valve and its mounting bracket to ensure they are secure.
b. Run the Head Calibration procedure for both heads.

For details, refer to Calibrating heads.

13. Verify the conveyor sensors operate as expected.
   
   On older systems, the conveyor nest sensor may need to be flipped so it looks upward.

   Batch systems should have SMEMA plugs installed in both SMEMA ports.

### 2.1. Pressure differential switch setup

**About this task**

The pressure differential switch is located inside the rear cabinet door.

**Procedure**

1. Test the pressure switch input:
   a. Turn on the air extraction system to full power.
   b. Check operation of the pressure switch input; it should be ON.
   c. Turn off the air extraction system.
   d. Check operation of the pressure switch input; it should be OFF.

2. Lower the extraction rate until 200-220 CFM registers at the exhaust port.
3. Repeat the pressure switch input test. If the pressure switch is OFF, adjust until input just turns ON.
4. Turn off the air extraction system and verify the pressure switch output turns OFF.
5. Lower the extraction rate to 160-180 CFM at the exhaust port.
6. Verify the pressure switch input turns OFF.
   
   If input stays ON, *slowly* turn the adjustment screw *clockwise* until the input turns OFF.
7. Re-check the input.
   
   The pressure switch should still turn ON with 200-220 CFM.

### 2.2. Calibrating heads

Head calibration requires the system be set to maintenance mode and is typically performed during initial setup.

**Before you begin**

Tools and equipment required:

   Calibration plate
   Allen key: 2 mm
   Valve mounted in each head position to be calibrated

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the Connect button.
b. Click OK on the success prompt.
c. From the main button bar, click the Home button.

2. Push the Emergency Stop button.

3. Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

4. If you’ll be calibrating a spray nozzle in either head position, manually unscrew the spray cap from the spray nozzle and set it aside.

5. Calibrate Head1:
   a. From the main menu, select Utilities → Setup → Head Calibration

   The Head Calibration window displays.

   ![Head Calibration Window](image)

   Please remove the ‘Spray Nozzle’ (Head 1) Cap.
   Place Calibration board at 0,0 position
   Press Calibrate head 1 button

   a. Z, X, Y

3. Installing software

This procedure details how to download and install SimpleCoat software on your laptop.

**Before you begin**

Verify the computer meets System requirements.

**Procedure**

1. Locate the download URL noted in the Download Instructions document accompanying your machine.
   The required user ID and password are included in the document.
2. Download the SimpleCoat .zip file to a local directory.
3. Extract the.zip file.
   File contents: User guide and .exe setup file used to install the SimpleCoat software
4. Run the setup.exe file.
5. Using the provided cable, plug the computer into the machine.
6. Verify the computer has the correct IP address according to Communication requirements.
7. Verify the computer is communicating with the machine. For details, refer to Connection status.

4. Uninstalling software

If you need to remove the SimpleCoat software from your laptop, use this procedure.

Procedure

1. Navigate to the Windows Control Panel.
2. Select Add/Remove Programs.
3. When the Install/Uninstall screen displays, scroll to and highlight SimpleCoat.
4. Select Add/Remove.
Chapter 3. Operating safety

Listed notices and warnings

- Safety goggles, gloves, and long sleeve clothing should be required safety wear when working with automated industrial systems.
- Read and understand all Notices and Safety labels.
- Read and understand all of the documentation before using the system.
- Do not disable safety features of the system.
- Do not remove any pneumatic attachment without first relieving the air pressure.
- Use only recommended parts for replacement.
- Remain clear of all moving parts while in operation.

Safety devices and guarding

The system has several built-in safety features to protect the operator from danger during normal working operation.

![WARNING]

Never tamper with, bypass, or disable safety features on the SimpleCoat system. GPD-Global, Inc. is not responsible for any dangerous conditions encountered, mechanical or human, because of alteration or disabling of any safety feature.

Safety circuit

The main power to the machine is monitored and controlled by a redundant safety circuit. Redundancy consists of two parallel electrical circuits working on tandem. The safety device monitors the state of the Emergency Stop button and other safety mechanisms, for example, an open door status. The power to the motor, as well as pneumatic supply, are cut automatically. When the safety device is actuated, all machine power and pneumatic motion is terminated.

Doors

The doors are monitored by limit switches. When the doors are open, the power to the pneumatics and motor are disconnected.

Related information

- Notices
- Safety labels
Chapter 4. User interface

These controls and indicators are the primary features typically used by the operator during operations.

1. Controls

Software controls

*Figure 4-1. Main menu and button bar located across top of main window*

<table>
<thead>
<tr>
<th>Item</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ON/OFF</td>
<td>Main power switch</td>
</tr>
<tr>
<td>2</td>
<td>Nozzle Air</td>
<td>Controls cone width and pattern for dispense valve:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Knob - air supply pressure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Air control and display - atomizes air.</td>
</tr>
<tr>
<td>3</td>
<td>Run/Maintenance</td>
<td>Key switch changes between run mode and maintenance mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maintenance mode prevents the front shield from being opened during processing, thus preventing fumes from escaping the dispense chamber while also preventing operators from exposure to a moving gantry.</td>
</tr>
<tr>
<td>4</td>
<td>Emergency Stop</td>
<td>Stops all machine movement and aborts any active program. A machine reboot is unnecessary.</td>
</tr>
</tbody>
</table>
Figure 4-3. Side panel controls

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material pressure regulators</td>
<td>External material reservoirs. Each reservoir has a pressure regulator for process optimization</td>
</tr>
</tbody>
</table>

Figure 4-4. Controls inside machine cabinet

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure differential switch</td>
<td>Air flow sensor for the exhaust port. Stops pneumatics and gantry motion if flow drops below set point.</td>
</tr>
</tbody>
</table>

2. Indicators

Machine status and error messages display in the main window and signal the user via the light tower.

Connection status

System status is indicated and error messages are displayed at the bottom of the main window.

Light tower

<table>
<thead>
<tr>
<th>Indicator Light</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>• Illuminated continuously - machine is functioning properly.</td>
</tr>
<tr>
<td></td>
<td>• Flashing - machine is on standby and is temporarily disabled.</td>
</tr>
<tr>
<td>Red</td>
<td>Illuminated continuously - machine has either been stopped by the operator or there is a problem and the machine has been disabled.</td>
</tr>
<tr>
<td></td>
<td>In a red light condition, the machine cannot be restarted until it is either restarted by the operator or the disabling condition has been rectified</td>
</tr>
</tbody>
</table>
Chapter 5. Operations

1. Start up

Procedure

1. Check and turn on air supply.
2. Close doors.
3. Turn on Main Power switch on machine front.
4. Release/Rotate the Emergency Stop button.
5. Check fluid air pressure.
6. Check exhaust air flow.
7. Click the Home button.

The system gantry moves to Home position.

2. Shutdown

Procedure

1. If the machine is in operation, wait until it has finished the process and returns to standby.
2. Press the Emergency Stop button.
3. Turn off Main Power switch to the system.
4. Clean any excess material from the tips of the needles.
5. Clean the valve(s) as specified by valve documents.
6. Clean the purge/park cups.

3. Emergency shutdown

The Emergency Stop button is for use if someone is endangered due to circumstances such as electric shock, unexpected valve movement, or damage to the PCB is possible.

Procedure

1. Push the Emergency Stop button.
2. To recover from emergency stop:
   a. Open the front door.
   b. Remove the PCB.
   c. Close the door.
   d. Rotate the Emergency Stop button to release it.

4. Homing the gantry

Homing the XYZ axes ensures the gantry is properly positioned for operations.

Procedure

1. Click the Home button in the main button menu.
The machine gantry moves immediately to the home position.

5. Set up for processing

Steps commonly performed to prepare the system for processing product.

About this task

Procedure

1. Mount heads.


3. If processing a new product, manually adjust conveyor width to accommodate the new product size:
   a. Manually loosen the two conveyor locks.

   Figure 5-1. One of two conveyor locks.

   b. Slide the rear conveyor rail into desired position.

   c. Tighten the two conveyor locks.

   Board stops and sensors do not require adjustment.

4. Solvent park cups and purge cups:

   Refer to Purge and solvent cups for additional details.
a. Fill the two park cups (at right) with solvent.
b. Verify the two purge cups (on left) are empty.

5. Load product.

6. Calibrating needle

Standard calibration sequence for needle valve.

**Before you begin**

Equipment required:

- Calibration plate
- Needle valve mounted in the head position to be calibrated

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the **Connect** button.
   b. Click **OK** on the success prompt.
   c. From the main button bar, click the **Home** button.

2. Push the **Emergency Stop** button.

3. Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

4. Calibrate needle:
   a. From the main menu, select **Utilities → Setup → Head Calibration**
      
      The Head Calibration window displays.
b. **CAUTION**

When either Calibrate Head button is pressed, the system immediately moves the gantry to the most recently taught calibration location. It first moves the X and Y axes, and then moves the Z axis. Ensure a clear travel path exists through the work area for both heads.

Click the applicable button: **Calibrate Head 1** or **Calibrate Head 2**.

c. Slide the calibration plate into the work area on the conveyor rails until it is snug against the board stops at 0,0 position.

*Figure 5-2. Calibration plate (PN 23116001)*
d. Using the X and Y jog buttons, center the tip of the needle over the hole in the calibration plate.
e. Using the Z axis jog buttons, adjust the tip of needle so it is positioned just above the surface of the calibration plate.
f. Click the Set button.
g. Click the OK button for each location prompt, and then select YES for the overall offset prompt.
h. Use the Z- button to raise the needle upward, away from the calibration plate.
i. Slide the calibration plate out of the immediate work area.

5. Remove the calibration plate from the work area and store for future use.

6. Close the Head Calibration window.

7. Click the Home button.

8. Set the Run/Maintenance keyed lock on the front control panel to Run.

9. Release the Emergency Stop button.

### 7. Purging a valve

Purge the valves to ensure they spray or dispense correctly.

**Procedure**

1. Verify that purge cups are in place at the purge location.

2. Decide which valve you want to purge, and then:
   - Click the Head1 button on the main button bar to purge the valve mounted in head1.
   - Click the Head2 button on the main button bar to purge the valve mounted in head2.

   The gantry moves immediately to the purge location for the amount of time specified in parameters.

3. Select the program file you want to download.

### 8. Loading a program

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   - a. From the main button bar, click the Connect button.
   - b. Click OK on the success prompt.
   - c. From the main button bar, click the Home button.

2. From the main button bar, click the Download button.

   The Select File dialog displays.
3. Select the program file you want to download.

4. To run a dry test of the entire program, select the **Dry Run** check box.

5. Click **OK**.

6. At the Gcodecomplete confirmation prompt, click **OK**.

7. At the download completion prompt, click **OK**.

### 9. Running a program

The most recently downloaded program will run.

**About this task**

A program can be run either wet (per the following instructions) or dry (select the **Dry Run** check box during the **Loading a program** procedure).

**Procedure**

1. From the main button bar, click the **Run** button.
   
   This screen displays.
2. Press the **Start** button.

   To know what to expect from the system, refer to *Conveyor theory of operation*.

   The most recently downloaded program runs.

3. As needed, end the process by pressing the **Stop** button.

   Home or park the system after use of the **Stop** button; otherwise, the gantry remains where it was when the program was aborted.

### 10. Valve adjustments

Once the valves are correctly set up, no further adjustments should be necessary.

**Note**

Adjusting gantry motion speed is typically a more effective way to change the application of coating material than adjusting the valve.

<table>
<thead>
<tr>
<th>Pressure Type</th>
<th>Applies to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid pressure</td>
<td>Needle valve</td>
</tr>
<tr>
<td>Air pressure</td>
<td>• Material</td>
</tr>
<tr>
<td></td>
<td>• Reservoir pressure (flow rate)</td>
</tr>
<tr>
<td></td>
<td>• Atomizing fluid (cone pattern width)</td>
</tr>
</tbody>
</table>

### 10.1. Adjusting dispense valve

Adjusting a dispense valve to achieve desired outcome may require several adjustment factors.

**Procedure**

1. **Flow rate** - Turn the knurled knob, located on top of the valve.
A constant flow of material is the desired result, i.e., this is how precise application is achieved.

This adjusts the flow rate of the conformal coating material.

2. **Needle size** - Select an appropriately sized needle for the valve.

![WARNING]

**A new needle can lead to damaging the dispenser or the PCB.**

Needles vary in length, so recalibrate each time a new needle is selected.

Needle size allows you to vary the coating width of an application.

3. **Dispense height** - Set the height of the dispense valve, using the software interface, at approximately 1-2mm above the component.

This recommended height is close enough to form a continuous bead but not so close as to conflict with a deformed PCB board.

### 10.2. Adjusting spray valve

Adjusting a spray valve requires several adjustment factors: valve stroke and reservoir flow rate, plus the width of the atomizing spray pattern.

- **Valve stroke & reservoir flow rate** - controlled by turning the knurled knob located on top of the valve.

- **Width of atomizing spray pattern** - controlled by adjusting the atomizing pressure of the fluid reservoir air pressure with the Nozzle Air control. Refer to Hardware controls

### 10.2.1. How to adjust spray valve

When first setting up the spray valve, use the following method.

**Procedure**

1. Adjust air pressure to zero.

2. Remove the spray valve cap and set it aside.

3. Turn the knurled knob, located on top of the valve, until the needle stroke is down all the way.

4. Open the valve and then set material flow to a rate of 2-3 drops per second by adjusting the valve stroke with the knurled knob and pressing the appropriate purge button (**Head1** or **Head2**).

   This process may require repeated cycles to achieve the correct flow.

5. Put the spray cap on the valve.

6. Continue using the appropriate purge button (**Head1** or **Head2**) while adjusting the atomizing pressure upwards until a satisfactory spray pattern is achieved on a test sample.
CAUTION

If the pressure is too high, the material will mist; and if pressure is too low, the material will splatter.

Guidelines: thin solvent-based conformal coatings require very low pressures (< 1 PSI); whereas, silicone materials can be sprayed at a pressure as high as 15 PSI.

7. Set the height of the spray valve via the software to approximately 10-20 mm above the board.

Adjusting spray height produces a variation in spray width typically 6-20 mm above the board, depending on the viscosity of the material and the atomizing air pressure of the system.
Chapter 6. Programming

Note

SimpleCoat software is designed to be user friendly. The operator must be familiar with Windows plus it is highly recommended that operators are comfortable with the most common features of these tools before attempting to program the system.

1. Valve adjustments
2. Diagram design
3. Creating a program, Combining two programs, or Editing a program, and testing each program step with Dry Run
4. Purging a valve
5. Setting parameters
6. Loading a program and testing the entire program with the Dry Run check box
7. Running a program

1. Diagram design

The first step of creating a process is designing a coating diagram - examining the PCB and deciding how coating is to be applied.

To design a coating diagram, you first need to identify the following area types on the board:

   - Areas that must not to be coated.
   - Areas that must be coated.
   - Areas that are unimportant relative to the coating process.

During the coating process, each area type can be handled by a different shape/ pattern and application by one of the two valves.

Table 6-1. Types of conformal patterns

<table>
<thead>
<tr>
<th>Pattern Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dot</td>
<td>Circular points made by dispense or spray valve while not moving.</td>
</tr>
<tr>
<td>Line</td>
<td>Single line of coating made by dispense or spray valve.</td>
</tr>
<tr>
<td>Area</td>
<td>Repeated lines of coating, made by dispense or spray valve.</td>
</tr>
<tr>
<td>Circle</td>
<td>Circular pattern made by dispense or spray valve.</td>
</tr>
<tr>
<td>Arc</td>
<td>Arc pattern made by dispense or spray valve.</td>
</tr>
</tbody>
</table>
2. Setting parameters

About this task

To enable faster programming after the material is correctly set up, the software allows you to set valve default parameters.

Procedure

1. From the main menu, select Utilities → Setup → Machine Parameters.

   The Machine Parameters window displays.
2. Click the **Nozzle Parameters** button.

   The Nozzle Parameters window displays.
3. Enter desired values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Delay</td>
<td>To avoid inertia issues with material exiting the valve, assign a time value to On Delay in order to adjust the start delay for each dispense point.</td>
</tr>
<tr>
<td>Height</td>
<td>This value can be manually entered, adjusted, or offset from the teach pendant capture.</td>
</tr>
<tr>
<td>Area Covered</td>
<td>This value helps calculate material usage and the number of passes needed during Area Fill operations.</td>
</tr>
<tr>
<td>Diameter</td>
<td></td>
</tr>
</tbody>
</table>

4. Click the Save button in the Nozzle Parameters window.

5. Click the Save & Close button in the Machine Parameters window.

3. Creating a program

There are various methods available for creating a new program.

Related information

- Section 3.1. Teach a program
- Section 3.2. Add program using image
- Section 3.3. Add program using values
- Section 3.4. Combining two programs
- Section 3.5. Teach subboards program

3.1. Teach a program

A new program can be taught by moving the gantry using the teach pendant feature in the PCB Data window.

Procedure

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the Connect button. Then click OK on the success prompt.
b. From the main button bar, click the **Home** button.

2. From the main menu, select **Teach** → **New**.

   The PCB Data window displays.

   ![PCB Data window](image)

3. Choose the Single option to program a single board.

   To program an array of subboards in a panel instead, follow the **Teach subboards program** instructions.

4. Enter board data:

   a. Enter board dimensions in the **Borders** and **Size of Board** fields in millimeters.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Definition</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Borders</td>
<td>Frames, fixtures, carriers, etc. measured from the PCB 0,0 point (bottom right hand corner).</td>
</tr>
<tr>
<td>Size of Board</td>
<td>Total X and Y dimensions of the substrate.</td>
</tr>
</tbody>
</table>

   b. Enter a value for **Overlap** in millimeters.

   This is the amount of overlap to be used for area fills. This value should be less than the value defined for **Nozzle Diameter**.

5. Click the **OK** button to continue.

   The Teach Mode window displays.
**Note**

General instructions are typically provided in the bottom left hand area of the window.

6. Click the **Teach** button.

The gantry immediately moves to the front of the work area, positioning Head1 to the right of the conveyor board stop.

The operation buttons in the button bar become available.

7. Teach a point:
a. Click an operation type button: **Line**, **Area Fill**, **Arc**, or **Circle**.

Nozzle, head, and operation parameter fields display.

b. Select desired head.

The head immediately toggles downward.

c. Select desired nozzle.

d. Using the provided XYZ buttons, move the selected head to desired XYZ coordinates.
e. Select desired speed.

f. Click the **Set** button to firm the point values.

Screen instructions prompt you to enter the next point.

8. (Optional) Set up tilt and rotate for Head1:

   The tilt and rotate function only displays on SimpleCoat TR models and only applies to Head1. Refer to [Tilt and rotate considerations](#) for additional details.

   a. Select the program pattern step to be dispensed at an angle by Head1.

   b. Select the **Rotate** check box.
Head1 valve rotates 90 degrees to achieve rotation.

c. Using the provided XYZ buttons, move the Head1 nozzle to desired XYZ coordinates.

d. Select the desired option: Tilt Right or Tilt Left
   Head1 valve tilts 45 degrees.

e. Click the Set button to firm the point values.

9. Teach additional program steps, as needed, following the same procedure described in the prior steps.

10. When you are done adding steps to the program, click the Home button located in the lower right hand corner of the window.

11. When prompted, select YES to save data.

12. When prompted, select OK to save file.

**Results**
The program is now ready to download and run.

**Related information**
- Section 3. Creating a program

**3.2. Add program using image**

If an image file (JPG) of the PCB is available, you can use it as a guide when creating a program.

**Before you begin**
Image files must meet Image programming requirements.
Procedure

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the Connect button. Then click OK on the success prompt.
   b. From the main button bar, click the Home button.

2. From the main menu, select File → Import → New Image.

   The Open Image File dialog displays.

3. Select the JPG file you want to import and click the OK button.

   The Graphic Editor screen displays.
4. Enter board dimensions:

   All units are mm by default.
   a. Enter the $Y$ and $X$ dimensions of the PCB.
   b. Enter the Max Component height of the PCB.
   c. Press the Set Zero button.

   The board image displays.

5. Define board corners:

   a. Click cursor on the bottom right hand corner of the image.

      You may zoom in on the image using the Zoom+ button.

   b. Click the cursor on the top left hand corner of the image.

   c. When prompted to set corners, select YES.

6. Define coating parameters:

   a. Select desired Head.

   b. Select desired Nozzle.

   c. Click a pattern button: **Point**, **Line**, **Area**, **Arc**, or **Circle**.

   d. Use the mouse to select and/or drag an area over the PCB image where you want to coat with the selected pattern.

   **Note**

   Arcs and circles must be taught in clockwise direction.
Coordinates for the selected area are written to the file.

7. Repeat the prior step, as needed, to define the entire coating process for the board.

8. Click the **Finish** button.

9. Save the program.

**Related information**

- Section 3. Creating a program

### 3.2.1. Image programming requirements

#### Image format

Image must be JPEG format. This includes: .jpg, .jpeg, .JPG, and .JPEG

**Note**

Only JPEG images are recognized by the SimpleCoat import feature.

#### Image sizing

- Maximum size: 920 x 620 pixels
- A 640 x 480 pixel photo can be imported without having to be resized.

**Note**

Images larger than the recommended maximum will be automatically cropped; i.e., only the upper left portion of the image will display.
Board alignment

Image must be aligned horizontally/vertically as squarely as possible, i.e., not rotated at an angle.

![Attention]

Automatic program realignment could cause unexpected results.
Align board properly in image.

Tips

- **Scanning.** Flat and low profile board can be scanned. Boards populated with tall components are not good candidates for this method unless depth of field can be controlled to offset blurred result.

- **Camera distance above board.** A minimum distance from the camera of 11.5” is required to photograph a 14” wide board.

3.3. Add program using values

If the required values are known, a new program can be created by entering those values.

Procedure

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the **Connect** button. Then click **OK** on the success prompt.
   b. From the main button bar, click the **Home** button.

2. From the main menu, select **File** → **New**.

   The PCB Data window displays.
3. Choose board layout:
   - Single board - select the *Single* option.
   - Array of subboards in a panel - select the *Multiple* option. Refer to Teach a subboards program for additional detail.

4. Enter board data:
   a. Enter board dimensions in the *Borders* and *Size of Board* fields in millimeters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borders</td>
<td>Frames, fixtures, carriers, etc. measured from the PCB 0,0 point (bottom right hand corner).</td>
</tr>
<tr>
<td>Size of Board</td>
<td>Total X and Y dimensions of the substrate.</td>
</tr>
</tbody>
</table>

   b. Enter a value for *Z Height* in millimeters.
   c. Enter a value for *Overlap* in millimeters.
      This is the amount of overlap to be used for area fills.

5. Click the **OK** button to continue.
   The PCB Data window displays.
6. To enter program step data:
   a. Click a pattern button: **Point**, **Line**, **Area**, **Arc**, or **Circle**.
      
      Coordinate fields display.
   b. Enter coordinate values.
   c. Select a nozzle type and head.
   d. Enter the speed of the valve to be used in the process.
e. Click the OK button to firm your entries.

7. Teach additional program steps, as needed, by repeating the prior step.

8. Click the Set button to firm your entries.

9. When prompted, select YES to save data.

10. When prompted, select OK to save file.

Related information

• Section 3. Creating a program

3.4. Combining two programs

It’s easy to add an existing program (set of steps) at the end of a different program.

Before you begin

Create the two programs you want to combine before proceeding.

About this task

Use this procedure to facilitate building a program that includes repetition by adding the steps from ‘file 2’ at the end of ‘file 1’.

Procedure

1. If the system and laptop are not already connected and if the robot is not already homed:
   
   a. From the main button bar, click the Connect button. Then click OK on the success prompt.
   
   b. From the main button bar, click the Home button.

2. From the main menu, select File → Add.

   The Add Files dialog displays.

3. Click the 1st File button.

4. Select the file that will become the initial steps of the program.

5. Click the 2nd File button.
6. Select the file that will become the final steps of the program.

7. Click the **Save As** button, enter a name for the new program, and then click the **OK** button.

8. At the prompt, confirm that you want to proceed if you still want ‘file 2’ added to the end of ‘file 1’.

**Related information**

- Section 3. Creating a program

### 3.5. Teach subboards program

The Multiple option enables you to teach a subboard program that is then automatically applied to a panel of multiple, identical subboards.

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the **Connect** button. Then click **OK** on the success prompt.
   b. From the main button bar, click the **Home** button.

2. From the main menu, select **Teach** → **New**.

   The PCB Data window displays.

3. Choose the Multiple option to program an array of subboards in a panel.

   To program a single board instead, follow the **Teach a program** instructions.

   Fields for multiple subboards display.
4. Enter board data:

a. Enter board dimensions in the **Borders** and **Size of Board** fields in millimeters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borders</td>
<td>Dimensions of pallet supporting the subboards; measured from the PCB 0,0 point (bottom right hand corner).</td>
</tr>
<tr>
<td>Size of Board</td>
<td>Total X and Y dimensions of the pallet supporting the subboards.</td>
</tr>
</tbody>
</table>

b. Enter the X and Y subboard dimensions in **Size** in millimeters.

c. Enter the number of subboards in the pallet in **Boards** for X and Y.

d. Enter the distance between subboards in **Gap** in millimeters for X and Y.

e. Enter a value for **Overlap** in millimeters.

This is the amount of overlap to be used for area fills. This value should be less than the value defined for **Nozzle Diameter**.

An image of the subboard array displays based on your input.
5. Click the OK button to continue.

The Teach Mode window displays.

Note
General instructions are typically provided in the bottom left hand area of the window.
6. Click the **Teach** button.

   The gantry immediately moves to the front of the work area, positioning Head1 to the right of the conveyor board stop.

   The operation buttons in the button bar become available.

7. Teach a point:
   
   a. Click an operation type button: **Line**, **Area Fill**, **Arc**, or **Circle**.

      Nozzle, head, and operation parameter fields display.
b. Select desired head.

The head immediately toggles downward.

---

**Important**

Head hardware toggles immediately when switching between heads.

Be aware that one head is always in the toggled down position in Teach mode.

---

c. Select desired nozzle.

d. Using the provided XYZ buttons, move the selected head to desired XYZ coordinates.

---

**CAUTION**

Avoid potential collisions - do NOT assume the Z axis will move first.

When switching heads, be sure to add a program step to move the Z axis upward in order to avoid potential head/substrate collisions.

---

e. Select desired speed.

f. Click the **Set** button to firm the point values.

---

Screen instructions prompt you to enter the next point.
8. (Optional) Set up tilt and rotate for Head1:

   The tilt and rotate function only displays on SimpleCoat TR models and only applies to Head1. Refer to Tilt and rotate considerations for additional details.

   a. Select the program pattern step to be dispensed at an angle by Head1.

   b. Select the Rotate check box.

      Head1 valve rotates 90 degrees to achieve rotation.

   c. Using the provided XYZ buttons, move the Head1 nozzle to desired XYZ coordinates.

   d. Select the desired option: Tilt Right or Tilt Left

      Head1 valve tilts 45 degrees.

   e. Click the Set button to firm the point values.

9. Teach additional program steps, as needed, following the same procedure described in the prior steps.
10. When you are done adding steps to the program, click the **Home** button located in the lower right hand corner of the window.

11. When prompted, select **YES** to save data.

12. When prompted, select **OK** to save file.

**Results**

The program is now ready to download and run.

**Related information**

- Section 3. Creating a program

4. **Editing a program**

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   a. From the main button bar, click the **Connect** button. Then click **OK** on the success prompt.
   b. From the main button bar, click the **Home** button.

2. Open an existing program:
   a. From the main menu, select **File → Open**

      The Select File dialog displays.
b. Select desired program and click **OK**.

The PCB Data window displays.

3. Select the program step to be edited using one of two methods - either scroll through the program and click on the step to be edited or skip to the next step and select a visual pattern.

   If you select a program step directly, the selected step is highlighted and parameter fields display.
4. To select a program step using a visual pattern instead of clicking directly on a program step:

The program step that corresponds to the visual pattern you choose will be selected.

a. From the menu, select **View Image**. A visual representation of the program displays.

**Note**

Unselected patterns display in yellow.

b. Click the pattern in the visual representation you want to edit. The corresponding program step is highlighted and parameter fields display.

**Note**

Selected patterns display in orange.
5. From the main menu, select **Modify → Edit**

The **OK** button displays.

6. Make desired edit(s).

7. Test edited results with a dry run:
   a. Click the **Try** button.
b. Select **YES** when prompted for dry run.

The dry run starts immediately.

8. Finalize your edits:
   
   a. Click the **OK** button.
   
   b. Click the **Set** button to firm the point values.
   
   c. When prompted, select **YES** to save data.
   
   d. When prompted, select **OK** to save file.

### 5. Adjusting purge time

**Procedure**

1. If the system and laptop are not already connected and if the robot is not already homed:
   
   a. From the main button bar, click the **Connect** button. Then click **OK** on the success prompt.
   
   b. From the main button bar, click the **Home** button.

2. From the main menu, select **Utilities** → **Setup** → **Machine Parameters**

3. In the Machine Parameters window, enter desired value in **Purge Time**.
6. **Tilt and rotate considerations**

**Note**

The tilt and rotate function applies only to Head1.

**Tip**

Adjust margin values when using the tilt and rotate feature:

- Use a top margin value of 60 mm.
- Use a left margin value of 45 mm.

- Tilt and rotate controls:
– display in the Teach Mode window for all SimpleCoat systems but only function for the SimpleCoat TR model.
– can be selected in any order.

• **Rotate** - moves the valve/Head1 from 0 to 90 degrees (or 90 to 0 degrees) about the Z axis.
• **Tilt Right, Tilt Left** - moves the valve/Head1 from 0 to +/- 45 degrees about the Z axis.
Keyed maintenance mode

Adjustments are kept to a minimum on the SimpleCoat system. When the Run/Maintenance keyed lock on the front control panel is set to Run, operators are prevented from opening the front shield during processing, thus preventing fumes from escaping the dispense chamber while also preventing operators from exposure to a moving gantry.

Note

Gantry speed is restricted while the system is set to maintenance mode; i.e., high speed motion is available only in run mode.

1. Maintenance schedule

<table>
<thead>
<tr>
<th>Type of Service</th>
<th>Every Shift</th>
<th>Weekly</th>
<th>Monthly</th>
<th>Quarterly</th>
<th>Biannual</th>
<th>Annually</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spray and Dispensing</td>
<td>Check fluid pressures.</td>
<td>• Check for any coating on all fixtures and surfaces and clean as necessary.</td>
<td>Check the fluid pipes for wear.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electro-Mechanical</td>
<td></td>
<td>• Check for leaks around fittings and tighten or replace as necessary.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mechanical Components</td>
<td></td>
<td>• Check stepper motors for overheating and smooth operation.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check for any chaffing of wires,</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

GPD Global Technical Support can perform the maintenance or train customer personnel to do so. Contact GPD Global Technical Support for more information about available services.
2. Inspection procedures

Before you begin
Set the Run/Maintenance keyed lock on the front control panel to Maintenance.

Procedure

1. Cables. Inspect the cables in the flexible coupling for excessive wear.

   Any worn cables should be replaced.

2. Valves. Valves should be maintained per procedures in the valve manuals.

3. Fume filter.

   a. Inspect the exhaust port filter below the stainless steel work area cover.

   The filter captures large particulates to allow toxic fumes to be pulled through the exhaust port at the rear of the system.

   Figure 7-1. Work area filter
b. The fume filter can be replaced by removing four fasteners.
Chapter 8. Troubleshooting

This section is intended for use by operator and maintenance personnel.

Technical support

1. If a problem arises, try to solve it by reviewing Fault diagnosis.

2. If a problem arises that you cannot solve, note the following information and then contact GPD Global Technical Support:

   • Record all information displayed by the system at the time the problem occurred.
   • Record the operation process in use when the fault occurred, including both when it occurred and what occurred.
   • If the fault is minor, attempt to repeat it. If the error is not repeatable, it may be due to operator error.

   **Note**

   In order to better diagnose machine faults, all maintenance records should be kept up-to-date, including replacement parts and service records.

1. Fault diagnosis

<table>
<thead>
<tr>
<th>Operation</th>
<th>Other Symptoms</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System is powered ON but will not operate.</td>
<td>Low exhaust error message displays.</td>
<td>As a mandatory safety precaution, the exhaust port includes a flow sensor. If flow drops below a set point, the sensor prevents the coating system from operating.</td>
<td>Replace fume filter per Inspection procedures.</td>
</tr>
<tr>
<td>System is powered ON but the PC has no power.</td>
<td>Cables are loose or not connected.</td>
<td>Enclosure is open so Safety switch is ON.</td>
<td>Close the Enclosure.</td>
</tr>
<tr>
<td>Homing the axes: the head moves past the Home Sensor and hits the hard stop.</td>
<td>The electrical enclosure does not have power</td>
<td>Fuse is blown.</td>
<td>Change the fuse.</td>
</tr>
<tr>
<td>Error occurs during Homing sequence.</td>
<td>Axes is not moving.</td>
<td>Home sensor is out of position.</td>
<td>Press the <strong>Emergency Stop</strong> button. Move the axis, realign the Home sensor, and check the gap.</td>
</tr>
<tr>
<td>X, Y, or Z axis does not move.</td>
<td>Head can be moved freely when power is ON.</td>
<td>The <strong>Emergency Stop</strong> button is depressed.</td>
<td>Release the <strong>Emergency Stop</strong> button.</td>
</tr>
<tr>
<td>Operation</td>
<td>Other Symptoms</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>PC indicates system is running properly.</td>
<td>Fuse is blown.</td>
<td>Replace the fuse.</td>
<td></td>
</tr>
<tr>
<td>Axis loses its position.</td>
<td>Axis speed is set too high.</td>
<td>Check the speed settings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Coupling is loose or has slipped.</td>
<td>Check and tighten the coupling.</td>
<td></td>
</tr>
<tr>
<td>Pneumatic actuator failure</td>
<td>Pneumatics operates slowly.</td>
<td>Air valve on the regulator is in OFF position or is at low pressure.</td>
<td>Open the air valve and adjust the air pressure.</td>
</tr>
<tr>
<td></td>
<td>Air line is blocked or restricted.</td>
<td>Check and take corrective action.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Loose fitting connection.</td>
<td>Tighten connection.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Damaged air line.</td>
<td>Replace the air line.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 9. System management

Topics include software version, security, and machine parameters.

1. Software version

To determine the level of SimpleCoat software in use, go to the main menu and click Help → About.

2. Security

Password
Access to various system features is controlled by a password.

Note
Contact GPD Global for additional password details.

3. Machine parameters

System parameters are typically set at the factory and are secured by a password.
# SimpleCoat Operation Manual

## Chapter 10. Parts list

### SimpleCoat system parts

<table>
<thead>
<tr>
<th>Part description</th>
<th>Location</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor, Stepper, 2 phase</td>
<td>Gantry</td>
<td>3500-0109</td>
</tr>
<tr>
<td>Controller, Stepper</td>
<td>Electrical cabinet - front</td>
<td>2200-0468</td>
</tr>
<tr>
<td>Controller, 4 Axis</td>
<td>Electrical cabinet - front</td>
<td>2200-0469</td>
</tr>
<tr>
<td>Sensor, Home</td>
<td>Z axis</td>
<td>5500-0091</td>
</tr>
<tr>
<td></td>
<td>X axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y axis</td>
<td></td>
</tr>
<tr>
<td>Sensor, Diffuse</td>
<td>Electrical cabinet - rear</td>
<td>5500-0092</td>
</tr>
<tr>
<td>Needle Package</td>
<td>Needle valve</td>
<td>2725-0070</td>
</tr>
<tr>
<td>Includes:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 each Needle, Teflon</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 each Needle, Teflon</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 each Needle, SS 303</td>
<td></td>
</tr>
</tbody>
</table>
Index

T

tilt and rotate, 5, 31, 45, 51